
Carryover Detection Tutorial

for the
MPXTM Driver Software

December 2017RUO-IDV-05-6901-A



This document is provided to customers who have purchased SCIEX equipment to use in the operation of such SCIEX
equipment. This document is copyright protected and any reproduction of this document or any part of this document is
strictly prohibited, except as SCIEX may authorize in writing.

Software that may be described in this document is furnished under a license agreement. It is against the law to copy, modify,
or distribute the software on any medium, except as specifically allowed in the license agreement. Furthermore, the license
agreement may prohibit the software from being disassembled, reverse engineered, or decompiled for any purpose. Warranties
are as stated therein.

Portions of this document may make reference to other manufacturers and/or their products, which may contain parts whose
names are registered as trademarks and/or function as trademarks of their respective owners. Any such use is intended only
to designate those manufacturers' products as supplied by SCIEX for incorporation into its equipment and does not imply
any right and/or license to use or permit others to use such manufacturers' and/or their product names as trademarks.

SCIEX warranties are limited to those express warranties provided at the time of sale or license of its products and are SCIEX’s
sole and exclusive representations, warranties, and obligations. SCIEX makes no other warranty of any kind whatsoever,
expressed or implied, including without limitation, warranties of merchantability or fitness for a particular purpose, whether
arising from a statute or otherwise in law or from a course of dealing or usage of trade, all of which are expressly disclaimed,
and assumes no responsibility or contingent liability, including indirect or consequential damages, for any use by the purchaser
or for any adverse circumstances arising therefrom.

For research use only. Not for use in diagnostic procedures.

AB Sciex is doing business as SCIEX.

The trademarks mentioned herein are the property of AB Sciex Pte. Ltd. or their respective owners.

AB SCIEX™ is being used under license.

© 2017 AB Sciex

AB Sciex Pte. Ltd.
Blk 33, #04-06
Marsiling Ind Estate Road 3
Woodlands Central Indus. Estate.
SINGAPORE 739256

MPXTM Driver SoftwareCarryover Detection Tutorial
RUO-IDV-05-6901-A2 / 23



1 Walk-Up Workspace in Version 2.0 of the MPXTM Driver Software.....................................................4
Submitted Batches ............................................................................................................................................................5

Change the Batch Order...............................................................................................................................................6
Status...........................................................................................................................................................................6

Samples in Batch................................................................................................................................................................6
Status...........................................................................................................................................................................7

Sample Execution History...................................................................................................................................................7
Instrument Status...............................................................................................................................................................8
Notification Messages Dialog............................................................................................................................................8

2 Carryover Detection...............................................................................................................................10
Requirements...................................................................................................................................................................10
Carryover Detection Messages.........................................................................................................................................11

3 Create a Batch........................................................................................................................................13
Create a Carryover Detection Compatible MultiQuantTM Software
Quantitation Method.......................................................................................................................................................15
Submit a Batch in the Walk-Up Workspace.....................................................................................................................17
Define Carryover Detection Limit Values..........................................................................................................................21

Carryover Detection TutorialMPXTM Driver Software
3 / 23RUO-IDV-05-6901-A

Contents



The Walk-Up workspace in the MPXTM driver software contains the following panes, each providing the user with
different access points to MPXTM driver software functionality and information related to the system:

• Submitted Batches pane. Refer to Submitted Batches on page 5.

• Samples in Batch pane. Refer to Samples in Batch on page 6.

• Sample Execution History pane. Refer to Sample Execution History on page 7.

• Instrument status pane. Refer to Instrument Status on page 8.

• Notification Messages dialog. Refer to Notification Messages Dialog on page 8.

Note: The  icon that is used to open the Notification Messages dialog is only accessible if messages or
warnings were generated during the sample run.

The Walk-Up workspace in the MPXTM driver software enables the user to submit batches, modify batch order,
and delete selected samples or batches through the MPXTM driver software. The user does not have to use the
Analyst

®
 software to perform these actions.

Refer to:

• Submit a Batch in the Walk-Up Workspace on page 17.

• Change the Batch Order on page 6.

MPXTM Driver SoftwareCarryover Detection Tutorial
RUO-IDV-05-6901-A4 / 23

1
Walk-Up Workspace in Version 2.0
of the MPXTM Driver Software



Figure 1-1 Walk-Up Workspace

Submitted Batches
The Submitted Batches pane contains a list of all of the batches that have been submitted. The pane contains one
row for each batch submitted, providing the user with information related to the status of the batch, the submission
order, the approximate batch start and finish times, the name of the batch, the batch owner, the number of samples
contained in the batch, and so on.

Figure 1-2 Submitted Batches Pane
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Change the Batch Order
The order of the batches can be changed according to user needs.

Note: Only batches that have not been submitted to the Analyst
®
 software queue can be moved up and down

or deleted in the MPXTM driver software Walk-Up workspace.

1. In the Submitted Batches pane, select the appropriate batch.

2. Do one of the following:

• To move the selected batch and all of the subsequent batches to the top of the list, click the  icon.

• To move the selected batch up in the list, one row at a time, click the  icon.

• To move the selected batch down in the list, one row at a time, click the  icon.

• To delete the selected batch from the list, click the  icon.

• To delete the selected batch and all of the subsequent batches from the list, click the  icon.

Status
The Status column shows a series of icons indicating the batch status:

DescriptionIcon

All of the samples in the batch have completed successfully, but at least one sample has
a warning message.

The batch is in progress.

The batch has been submitted, but is waiting to begin.

The batch has completed successfully, but at least one sample has failed.

All of the samples in the batch have completed successfully, with no warning message.

At least one sample in the batch has failed.

Samples in Batch
The Samples in Batch pane contains a list of all of the samples within a batch. The Samples in Batch pane contains
one row for each sample in the selected batch, providing the user with information related to the status of the
sample, the submission order, the approximate sample start and finish times, the name of the sample, the assigned
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and submission stream, the barcode of the sample, the plate position, and so on. Any RTD3 Carryover Detection
messages related to the sample are shown in the Message column.

Figure 1-3 Samples in Batch

Status
The Status column shows a series of icons indicating the sample status:

DescriptionIcon

The sample is in progress.

The sample is waiting.

The sample has completed successfully, but contains a warning message.

The sample has completed successfully.

The sample has failed.

Sample Execution History
The Sample Execution History pane contains a complete list of all of the injected samples, Blank sample re-injections,
and carryover sample re-injections. The Sample Execution History pane contains one row for each submitted
sample, providing the user with information related to the status of the sample, the submission order, the
approximate sample start and finish times, the name of the sample, the associated stream number, the plate and
vial positions, and so on. Any RTD3 Carryover Detection messages related to the sample are shown in the Message
column.
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Figure 1-4 Sample Execution History

Instrument Status
The instrument status panel is shown at the bottom of all of the MPXTM driver software workspaces. The status
panel provides a visual status of the mass spectrometer, LC stream 1, and LC stream 2.

Figure 1-5 Instrument Status Panel

Table 1-1 Status Icons

DescriptionIcon

Ready

Standby

Fault

Notification Messages Dialog
The Notification Messages dialog contains a list of all important messages and warnings generated during the
sample run. The messages identify issues with the MPXTM-2 High Throughput System. Users can acknowledge and
clear these messages, as required.
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1. To access the Notification Messages dialog, click the  icon in the bottom-right corner of the Walk-Up
workspace.

Figure 1-6 Notifications Messages Dialog

2. To delete the messages, do one of the following:

• To delete an individual message, click the  icon that is shown at the right of the message.

• To delete all of the messages, click Clear All at the bottom of the Notification Messages dialog.
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The Real Time Data Dependent Decision (RTD3) Carryover Detection feature enables the user to set a series of Low
and High concentration thresholds for various analytes. When the Carryover Detection option is selected, the RTD3

logic improves sample throughput by minimizing the number of sample re-injections that need to be performed
due to sample stream contamination or suspected carryover.

Carryover Detection is designed for high throughput analytical workflows using the same analytical methods on
Stream 1 and Stream 2.

After a series of Low and High thresholds have been set in the MPXTM driver software, the RTD3 can flag:

• Unknown sample concentration level that exceeds a specified High limit value or a specified Region Height
value.

• Blank sample concentration level that exceeds a specified Low limit value.

When an Unknown sample concentration level is below the specified High limit value, the next sample is injected.
When an Unknown sample concentration level exceeds the specified High limit value, a Blank sample is automatically
injected. For systems equipped with a CTC autosampler, the Blank sample is injected on the other stream. For
systems equipped with a Shimadzu autosampler, the Blank sample is injected on the same stream.

For systems equipped with a CTC autosampler, if the Unknown sample concentration level exceeds the Lower
limit value and was preceded by a sample with a concentration level that exceeded the High limit value, then
Carryover Detection is enabled and the Unknown sample is flagged with the message Carryover was detected.
The Unknown sample is re-injected at the end of the batch.

When a Blank sample concentration level is below the specified Low limit value, the stream is considered clean
and the next sample is injected. When a Blank sample concentration level exceeds the Low limit value, the RTD3

functionality will inject up to three Blank samples, in succession. If the calculated sample concentration of the
third Blank sample still exceeds the Low limit value, then the sample stream stops injecting to prevent carryover
contamination of the other samples in the batch.

Because there are small differences in response between the two streams, Carryover Detection does not provide
an absolute quantitation value, but rather a rough concentration guide that is useful for flagging suspect samples.
For final analytical quantitation and reporting, we recommend that the entire data file be processed using either
the MultiQuantTM software or the Analyst

®
 software to confirm the findings.

Requirements
Carryover Detection can only be performed in the Walk-Up workspace of the MPXTM 2.0 driver software.

The Carryover Detection function requires the following components:
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• An MPXTM driver software acquisition method (stream 1 or stream 2 only). The method must include an Analyte
ID for each MRM transition. Refer to Create the MS Component of a Method in the MPXTM®

 driver software
Help.

• An Analyst
®
 software quantitation method. Refer to Create the LC Component of a Method in the MPXTM®

driver software Help.

• A sample batch created using the Analyst
®
 software, with a single sample set containing the sample name,

location, sample type, and the concentration values for calibration samples. Refer to Create a Batch on page
13.

• A MultiQuantTM software, version 3.0.2 or later, quantitation method. Refer to Create a Carryover Detection
Compatible MultiQuantTM Software Quantitation Method on page 15. The same MultiQuantTM software method
must be used for both stream 1 and stream 2.

Note: Version 3.0.2 of the MultiQuantTM software is only compatible with the 64-bit version of the Microsoft
Windows 7 operating system. Version 3.0.3 of the MultiQuantTM software is compatible with the 64-bit version
of both the Microsoft Windows 7 and the Windows 10 operating systems.

• The Carryover Detection check box must be selected on the Submit Batch dialog. This check box is only
available for selection if all of the above criteria is met.

Carryover Detection Messages
Table 2-1 Messages

DescriptionMessage

The concentration level of an Unknown sample exceeds
the specified High limit value.

Above upper concentration limit was detected

The concentration level of an Unknown sample exceeds
the specified Region Height value.

Above region height threshold was detected

The concentration level of a Blank sample exceeds the
specified Low limit value.

Above lower concentration limit was detected

The concentration level of an Unknown sample exceeds
the specified Low limit value and was preceded by a
sample that exceeded the specified High Limit value.

Carryover was detected
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Figure 2-1 Example Messages
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Refer to Requirements on page 10 for a list of criteria that must be met for Carryover Detection to function as
expected.

Note: For the Carryover Detection feature to be available in the MPXTM driver software, the batch must be set
up as follows:

• At least one calibrator sample must be identified as a Standard.

Note: If multiple Standard samples are used, then the same Sample Name can be used for each Standard
sample. However, the Vial Position for each sample must be unique.

• At least one negative control sample must be identified as a Blank.

Note:  If multiple Blank samples are used, then the same Sample Name can be used for each Blank sample.
However, the Vial Position for each sample must be unique. The RTD3 (Real Time Data Dependent Decision)
feature uses the most recent Blank sample which does not exceed the low concentration limit set by the
user. Refer to Define Carryover Detection Limit Values on page 21.

• The Standard samples must precede the Blank samples in the batch.

• Samples that are to be evaluated by the Carryover Detection feature must be identified as Unknown.

Note:  If multiple Unknown samples are used, then the same Sample Name can be used for each Unknown
sample. However, the Vial Position for each sample must be unique.

• Samples identified as Solvent, Double Blank, or QC can be inserted anywhere in the batch. These sample
types are ignored by the Carryover Detection feature and are not processed by the RTD3 method.

1. In the Analyst
®
 software, make sure that the correct project folder is selected.

2. Click File > New.

The New dialog opens.

3. Click Acquisition Batch and then click OK.

The Batch Editor window opens.

4. On the Sample tab, in the Set field, type a name for the set and then click Add Set.

5. Click Add Samples.
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The Add Samples dialog opens.

6. Type the number of samples for the set in the Number field and then click OK.

The Add Samples dialog closes.

7. In the Acquisition field, select the acquisition method for the set.

8. In the Quantitation field, select the quantitation method for the set.

9. In the samples table, type the Sample Name, Vial Position, and Data File for each sample in the batch.

Note: The information provided in Figure 3-1 is for information purposes only.

Figure 3-1 Create Batch—Sample Tab

10. Click the Quantitation tab.

11. Type the appropriate Quant Type information for each sample in the batch.

Note: If multiple Standard, Blank, or Unknown samples are used, then the same Sample Name can be used
for each sample but the Vial Position for each sample should be unique.
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Figure 3-2 Create Batch—Quantitation Tab

12. Click File > Save.

The Save Acquisition Batch dialog opens.

13. Type a File name for the batch and then click Save.

Create a Carryover Detection Compatible
MultiQuantTM Software Quantitation Method
The quality of the quantitation method used determines how effectively carryover can be detected. Because the
Carryover Detection functionality generates a concentration value for each Unknown and Blank sample, it is
important that the concentration be as accurate and reliable as possible so that the appropriate flags can be
generated by RTD3.

1. If the MultiQuantTM software is not open, then double-click MultiQuant under Companion Software
on the Navigation bar of the Analyst

®
 software.

Tip! When using the RTD3 Carryover Detection feature, use the SignalFinderTM algorithm. This algorithm
provides a wider linear dynamic range and more accurate quantitation results. In the MultiQuantTM software,
click Edit > Project Integration Defaults and then select SignalFinder1 from the Integration Algorithm list.

2. In the MultiQuantTM software, click File > New Quantitation Method.

3. Select the appropriate Sample file from the list provided and then click OK.

If the required Sample file is not shown, then browse to the appropriate folder and select the file.
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4. On the Components tab, select the check box beside the internal standard, if applicable.

5. Select the Group ID and the IS name from the list provided.

6. Verify the Q1/Q3 Transition from the list provided and modify, if required.

Figure 3-3 Components Tab

7. On the  Integration & Regression tab, type the appropriate values for the integration parameters.

Tip! For single point calibrators, type Linear Through Zero in the Fit field. If applicable, for internal standards,
type an area value that is approximately 20% to 30% of the average value for the internal standard in the
Min. Peak Height field.

8. On the Outlier Settings tab, type the appropriate values for the calculated concentration limits.

Note:  For the RTD3 functionality, the Lower Limit of Calculated Concentration (LLCC) and the Upper Limit
of Calculated Concentration (ULCC) fields are the most important. These values set the concentration limits
used by the RTD3 Carryover Detection feature to assess the Above Lower Concentration Limit and the Above
Upper Concentration Limit flagging comments. The LLCC and ULCC values are used when a selected
MultiQuantTM software method is used for carryover detection. The default values in the Carryover Detection
pane of the Walk-Up workspace can be modified during batch submission, if required.
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Figure 3-4 Outlier Settings Tab

Submit a Batch in the Walk-Up Workspace

1. In the MPXTM driver software, in the Workspace pane, click Walk-Up.

The Walk-Up workspace opens.
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Figure 3-5 Walk-Up Workspace

2. In the Walk-Up section, click Submit Batch.

The Submit Batch dialog opens.
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Figure 3-6 Submit Batch Dialog

3. Make sure that the correct Project is shown and then select the appropriate batch from the list provided.

Note:  If the batch does not meet the Carryover Detection criteria, then the batch can still be submitted but
the Carryover Detection feature will not be invoked. Refer to Requirements on page 10.

Figure 3-7 Submit Batch Dialog—Regular Batch
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Note:  If the batch meets the criteria for the Carryover Detection feature, then the Carryover Detection
check box is automatically selected and a list of available MultiQuantTM software qmethods is shown.

4. Select the appropriate qmethod from the list provided.

A list of defined limit values that are associated with the selected method is shown. Refer to Define Carryover
Detection Limit Values on page 21.

Figure 3-8 Submit Batch Dialog—Carryover Detection Batch

Note: All of the transitions contained in the MultiQuantTM software method are listed. The Low, High, and
Region Height values can be modified, if required. Refer to Define Carryover Detection Limit Values on page
21. If the method is being used for the first time, then the original values are shown. If the method has been
used in a previous submission, then the values that were used for the previous submission are shown.

5. After all of the required changes have been made, click Submit.

The batch is shown in the Submitted Batches pane of the Walk-Up workspace. Any RTD3 Carryover Detection
messages related to the sample are shown in the Messages column.
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Figure 3-9 Samples in Batch

Note: The data (wiff) file that is generated will contain all of the samples in the submitted batch, including
any re-injected Blank samples and any re-injected carryover flagged samples.

Define Carryover Detection Limit Values
Notes:

• The Carryover Detection limit values must be defined during batch submission in the Walk-Up workspace.

• Although the MultiQuantTM software allows a maximum of 26 digits in each of the Lower Limit Calculated
Concentration and Upper Limit Calculated Concentration fields, a maximum of 7 digits is allowed in the
Carryover Detection Limit values table.

• Commas (,) are not supported as decimal separators. If a comma is used, then the MPXTM driver software
ignores the comma and interprets the value as an integer. For example, if 5,01 is typed, then the software
interprets this value as 501.

1. Make sure that the Use check box is selected for each analyte to be evaluated by the Real Time Data Dependent
Decision (RTD3) feature.

Note: By default, the Use check box is selected for all analytes. Users can clear the check box, if required.
However, if the Use check box is not selected, then the corresponding analyte will not be evaluated by the
RTD3 carryover detection function. The Use check box cannot be selected for analytes that have been identified
as internal standards in the quantitation method (qmethod) file.
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Figure 3-10 Use Check Box

2. Set the detection limit values using the guidelines provided. Refer to Table 3-1.

Table 3-1 Detection Limit Value Guidelines

DescriptionField

The name of the analyte, as defined in the quantitation method (qmethod) file. This
field is automatically populated and cannot be modified.

Name

The lower limit of the calculated concentration used by the RTD3 Carryover Detection
function for the evaluation of Blank samples.

• The Low value is mandatory.

• The Low value can be modified.

• The Low value cannot be less than or equal to zero.

• The Low value can contain a maximum of five decimal places and seven digits.

• The Low value must be between 0.00001 and 9999999.

• The Low value must be less than the High value.

Low
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Table 3-1 Detection Limit Value Guidelines (continued)

DescriptionField

The upper limit of the calculated concentration used by the RTD3 Carryover Detection
function for the evaluation of Unknown samples.

• The High value can be modified.

• The High value cannot be less than or equal to zero.

• The High value can contain a maximum of five decimal places and seven digits.

• The High value must be between 0.00001 and 9999999.

• The High value must be greater than the Low value.

• If the corresponding Region Height value is provided, then the High value can be
left blank.

High

An upper limit defined in counts per second (cps) either alone or in conjunction with
the High value.

• The Region Height window is equivalent to 1.5 times the normal Retention Time
window used for the quantitation method (qmethod) analyte integration.

• The format is scientific notation only, with a maximum of two decimal places and
a maximum exponent value of seven.

• Acceptable formats include values such as: 1e7, 1.0e7, and 9.99e6.

Region Height

Carryover Detection TutorialMPXTM Driver Software
23 / 23RUO-IDV-05-6901-A

Create a Batch


	MPX Driver Software
	Contents
	Walk-Up Workspace in Version 2.0 of the MPX Driver Software
	Submitted Batches
	Change the Batch Order
	Status

	Samples in Batch
	Status

	Sample Execution History
	Instrument Status
	Notification Messages Dialog

	Carryover Detection
	Requirements
	Carryover Detection Messages

	Create a Batch
	Create a Carryover Detection Compatible MultiQuant Software Quantitation Method
	Submit a Batch in the Walk-Up Workspace
	Define Carryover Detection Limit Values



